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Important user information

All users must read this entire manual to fully 
understand the safe use of Ettan DIGE Imager.

IMPORTANT! Ettan Dige Imager is intended for 
laboratory use only, not for clinical or in vitro use, or for 
diagnostic purposes.

WARNING!

The WARNING! sign highlights 
instructions that must be followed to 
avoid personal injury. Do not proceed 
until all stated conditions are clearly 
understood and met.

CAUTION!

The CAUTION! sign highlights instructions that must be 
followed to avoid damage to the product or other 
equipment. Do not proceed until all stated conditions 
are met and clearly understood.

Notes

Note: A Note is used to indicate information that is 
important for trouble-free and optimal use of the 
product.

Recycling

This symbol indicates that the waste of 
electrical and electronic equipment must not 
be disposed as unsorted municipal waste and 
must be collected separately. Please contact 
an authorized representative of the 
manufacturer for information concerning the 
decommissioning of equipment.

WARNING! 

This is a Class A product. In a domestic environment, it 
might cause radio interference, in which case the user 
might be required to take appropriate measures.

WARNING! 

All repairs should be done by personnel authorized by 
GE Healthcare. Do not open any covers or replace any 
parts unless specifically stated in the instructions.

WARNING! 

The computer should be installed and used according 
to the instructions provided by the manufacturer of the 
computer.

WARNING! 

The mains power switch or other disconnect device 
must always be easy to access.

CE-certification

This product complies with the European directives 
listed below, by fulfilling corresponding standards.

A copy of the Declaration of Conformity is available on 
request.

• 73/23/EEC, Low Voltage Directive

• 89/336/EEC, EMC Directive

The CE logo and corresponding declaration of 
conformity, is valid for the instrument when it is:

• used as a stand-alone unit, or

• connected to other CE-marked GE Healthcare 
instruments, or

• connected to other products recommended or 
described in this manual, and

• used in the same state as it was delivered from 
GEHealthcare except for alterations described in this 
manual.

Note: The Declaration of conformity is valid only for 
systems that are marked with the CE logo:
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Preface

Ettan DIGE Imager
Ettan™ DIGE Imager is a scanner intended for scanning gels and membranes 
containing CyDye™ DIGE Fluor dye-labeled proteins or gels post stained with 
Deep Purple or Sypro Ruby. Ettan DIGE Imager should be used with gel 
cassettes from GE Healthcare. 

The scanner is controlled with Ettan DIGE Imager software, which can be set up 
for a variety of gel formats. The software includes a report viewer with functions 
for image enhancement and distance measuring.

The User Manual
The Ettan DIGE Imager User Manual is intended for lab personnel performing 
analysis of fluorescent 2D-gels, and for service personnel performing 
maintenance and repairs. The user manual comprises the following chapters:

Important User Information
Safety information, conventions used in the manual.

Installing the Scanner
Setting up the scanner and the software

Getting Started
Preparing gel cassettes and setting up a scan. Scanning samples.

Customizing Templates and Gel Formats
Using standard and customized gel formats.

Using the Report Viewer
Setting Image Contrast, measuring distances and saving modified images.

File Formats
File naming conventions

WARNING! Ettan DIGE Imager is intended for laboratory 
use only, not for clinical or in vitro use, or for diagnostic 
purposes.

DIGE_imager_11003659AC.book  Page 3  Tuesday, January 8, 2008  11:44 AM



Preface

4 Ettan DIGE Imager User Manual 11-0036-59 Edition AC

Maintaining the System
Cleaning the scanner and replacing spare parts.

Troubleshooting
Customer verification sheet, check that the instrument is working properly.

Appendix
Filter details, related products, consumables, and spare parts.
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1 Important User Information

1.1 Warnings and Cautions
Hazardous conditions are indicated in the User Manual by Warning and Caution 
messages.

1.2 Safety Information
The Ettan DIGE Imager system is equipped with safety labels and interlocks to 
help protect you from potential injury that may be caused by ultraviolet light, 
heat, or the high voltage of the scanner's lamp.

1.2.1 Ultraviolet Light and Heat
The following hazards are associated with the scanner lamp assembly's high-
intensity, metal halide bulb:

• Damage to eyes and skin caused by exposure to ultraviolet radiation

• Burns caused by contact with a hot lamp assembly

• Fire ignited by hot lamp assembly

• Interaction of nearby chemicals with ultraviolet radiation

• Damage caused by placing apparatus too close to the scanner

To avoid injury or damage, do not remove the scanner cover. Also keep 
chemicals and equipment that are sensitive to ultraviolet radiation away from 
the scanner.

Note: The rear cover is equipped with a safety interlock that turns the lamp off 

WARNING! The Warning sign highlights an instruction that 
must be strictly followed in order to avoid personal injury. Do 
not proceed until you clearly understand the instructions, 
and all stated conditions are met.

CAUTION! Indicates important information regarding potential damage to 
equipment or software.

Follow the instructions in detail in order to avoid damage to the instrument or 
other equipment. Do not proceed until you clearly understand the 
instructions, and all stated conditions are met.
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if the cover is removed while the lamp is on.

WARNING!   Under certain conditions, the bulb can explode. 
If this occurs, the fumes can be toxic. Evacuate the room 
immediately and remain out of the room for at least 30 
minutes. 
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1.2.2 Caution and Warning Labels
The following labels are found on the product. 

Fig 1-1. Description of Caution and Warning Labels

Hazardous Voltage Warning Label

WARNING—HAZARDOUS VOLTAGE 
ENCLOSED

Voltage or current hazard sufficient to 
cause shock, burn, or death.

Disconnect the system by unplugging 
the power cord before servicing.

Heavy Objects Caution Label

CAUTION—HEAVY OBJECT

Can cause strain or back injury.

Use proper lifting techniques when 
moving.

Equipment marked with this label 
weighs 25 lbs. (11.34 kg) or more and 
should be lifted by two people.

Hot Surfaces Caution Label

CAUTION—HOT SURFACES

Do not touch. 

Allow surfaces to cool prior to 
servicing. 
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Fig 1-2. Recycle symbol

Waste of electrical and electronic equipment

This symbol indicates that the waste 
of electrical and electronic 
equipment must not be disposed as 
unsorted municipal waste and must 
be collected separately. Please 
contact an authorized 
representative of the manufacturer 
for information concerning the 
decommissioning of your 
equipment.
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The following safety labels are found on the back of the product.

Fig 1-3. Location of Caution and Warning labels

1.3 CE Certification
This product meets the requirements of all applicable CE-directives. A copy of 
the corresponding Declaration of Conformity is available on request.

Access door at back of scanner 

Back of scanner with Access door removed
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2 Installing the Scanner

This chapter describes the installation of the Ettan DIGE Imager (the scanner). It 
also describes components and applicable requirements.

2.1 About the Scanner
The scanner allows you to scan a variety of gel formats.

Fig 2-1. The scanner

The scanner has the following replaceable parts:

2.2 Set Up the Scanner
Before you set up the scanner, review the installation requirements. Then use 
the following instructions to unpack the scanner and connect it to the 
workstation.

Component Part Number

Lamp Assembly 28401403

Protective Window 28401414
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2.2.1 Installation Requirements and Recommendations
Before you install the scanner, make sure that your facility supports the 
following scanner requirements.

Electrical Requirements Voltage: 100 - 240 VAC ± 10%

Frequency 50/60 Hz ± 2 Hz 

Circuit Rating 100 V: 5.6 A

240 V: 2.1 A

Transient over-voltages Must be in accordance with 
Installation Category II in IEC 664

Operating Environment 
Requirements

Indoor use

Temperature 59 - 90 °F (15 - 32 °C), daily variation 
of no more than 3 °F (1.8 °C)

Humidity Maximum relative humidity less 
than or equal to 80% non-
condensing. (High humidity can 
result in condensation on the 
camera window. Excessive humidity 
may also reduce filter life.)

Weight Approximately 140 lbs. (64 kg.)

Altitude Up to 6550 ft. (2000 m)

Pollution POLLUTION DEGREE 2
1
 in 

accordance with IEC 664

1
 UL 3101-1, First Edition, Underwriters Laboratories, Inc.® defines 
POLLUTION DEGREE 2 as “Normally only non-conductive pollution 
occurs. Occasionally, however, a temporary conductivity caused by 
condensation must be expected.”

Space Requirements Workstation: 3 ft. x 3 ft . (90 cm x 90 
cm) counter space

Scanner: 2.5 ft. x 3.5 ft. (77 cm x 
107 cm) counter space
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Fig 2-2. Scanner counter space requirements

2.2.2 Minimum Workstation Requirements.
Processor P4 2GHz

Graphics card 64Mb with support for 1280x1024 
display

System Memory 1 Gb

Operating System Windows XP ver. SP2

Network cards 1Gb network card required to 
connect to the Ettan DIGE Imager 
Additional network card required if 
the workstation is connected to a 
LAN 

PC Hard Drive Free Space 1Gb minimum (50 Gb 
recommended if images are 
stored locally)

Monitor Supports 1280x1024 display

Mouse Wheel Mouse

   3.5 ft (107 cm)

   
2.

5 
ft

. (
77

 c
m

)

WARNING! The workstation should be installed and used 
according to the instructions provided by the manufacturer of 
the workstation.
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2.2.3 Install the Scanner
Unpack and install the scanner as shown below.

To install the Scanner

1 Remove the scanner from the crate and place it on a flat level surface.

2 Slide the door fully open to get access to the stage area.

Fig 2-3. Opening the scanner door

3 In the upper left corner of the stage area, use a hex key to loosen the 
locking bolt that holds the stage in place and remove the locking bolt.

WARNING! Do not attempt to lift the scanner by yourself. Two 
people are required to lift the scanner.
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Fig 2-4. Removing the locking bolt

4 Remove the locking bolt and the round metal plate.

5 Store the locking bolt and the plate as follows:

1 Remove the rear panel by loosening the screws at the bottom of the 
panel.

CAUTION! Do not discard the locking bolt and the plate. You will need them If 
you ever have to move the scanner.
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2 Gently pull up on the panel as you open it to remove it .

3 Open the optics bay door (next to the lamp access door).

4 Install the locking bolt and the plate in their storage position.

5 Reassemble the rear panel.

Optics Bay 
Door

DIGE_imager_11003659AC.book  Page 16  Tuesday, January 8, 2008  11:44 AM



Ettan DIGE Imager User Manual 11-0036-59 Edition AC 17

Installing the Scanner 2

6 Connect the scanner cable to the workstation as follows:

Fig 2-5. Power and cable connections

7 Plug in the scanner and the workstation.

8 Press the Power switch on the side of the scanner and make sure that the 
POWER light turns on. 

Back of Workstation

Power Cable

Power Cable

  
Network Cable

Side of Scanner

WARNING! To permit sufficient cooling, ensure that the vents 
on the side panels of the scanner are not covered.
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Power Switch

Scanner Lights

WARNING! Do not block the side panel of the scanner. The 
mains power switch must always be easy to access.
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2.3 Set up the Workstation 

2.3.1 Set up the Workstation Network Parameters
Use the following instructions to configure the workstation so that it can be 
connected to the scanner. 

To Configure the Workstation Network Interface

1 Turn on the Workstation and the monitor.

2 From the Windows Start menu, open the Control Panel. 

3 In the Control Panel, click Network and Internet Connections.

Note: If the Control Panel view is different from the view shown above, click 
Switch to Category View. 
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4 In the Network and Internet window, select Network Connections.

5 On the right side of the Network Connections window, select Local Area 
Connection 2. Then select Change settings of this connection (under 
Network Tasks). 
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6 In the Internet Protocol (TCP/IP) Properties dialog box, select Internet 
Protocol (TCP/IP). 

7 In the Internet Protocol (TCP/IP) Properties dialog box, enter the address as 
follows:

1 Select Use the following IP address. 

2 In the IP address field, enter 159.159.159.2. 

3 In the Subnet mask field, enter 255.255.0.0. 

4 Leave the remaining fields blank.

5 Click OK. 
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8 Close the Local Area Connection 2 Properties dialog box. 

9 In the Network Connections window, select Local Area Connection 2 and 
click Change Windows Firewall Settings. 

10 In the Windows Firewall window, click the Advanced tab. 
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11 Verify the Local Area Connection 2 box is not checked and click OK. 

12 Close the Network Connections window.

To Map the Scanner Address
1 Double click the My Computer desktop icon. 

2 Double click the Local Disk (C:) icon 

Note: The C: drive may have be named differently than Local Disk.
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3 Double click the Windows folder icon.

4 If the following message is displayed, click Show the contents of this 
folder. 
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5 Browse to the Windows\system32\drivers\etc folder and double click the 
hosts file icon. 

6 If the following message is displayed, click Select the program from a list 
and click OK. 
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7 In the Open With dialog box, select Notepad and click OK. 

8 In the Notepad text editor, append the following line to the bottom of the 
text file: 159.159.159.1 DIGEImager. 

9 From the File menu, click Save. 

10 Close the Notepad window.
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2.3.2 Install the Scanner software
Use the CD with the auto run script to install the software as follows.

To verify that the workstation can connect to the scanner:

1 Start the workstation and place the CD in the CD ROM.

2 Follow the instructions on the screen to install the software.

2.3.3 Verify the installation
To verify that the workstation can connect to the scanner:

1 Make sure that the Scanner SCANNING light is off.

2 Double click the Ettan DIGE icon to start the workstation software. 

3 If the “Scanner Not Responding” dialog is displayed, click Yes to keep trying. 

IMPORTANT! Study the readme file thoroughly.
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If the monitor displays the “Connection Failed” message, make sure that 
the network cable is connected properly, and that the scanner SCANNING 
light is off. 

When the workstation connects to the scanner, the Ettan DIGE Imager Window 
opens.
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3 Getting Started

This chapter shows how to set up and run a scan, and print a scan report. 

3.1 Turn the System On and Off

To turn on the system

1 Make sure that the scanner door is closed.

2 Turn on the scanner and the workstation. When you turn on the scanner, 
the POWER light turns on. 

3 The yellow SCANNING light turns on as the scanner initializes. When the 
scanner completes its initialization, the SCANNING light turns off.

The Scanner has two other status indicators:

• The SCANNING light turns on when the system is acquiring data.

• The READY light turns on when the system is ready for scanning (the 
lamp is on and the camera has cooled to the required operating 
temperature). 
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Fig 3-1. Scanner power switch and lights.

4 After the SCANNING light turns off, double click the Ettan DIGE icon on the 
desktop to start the DIGE software.

Power Switch

Scanner Lights
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• If the “Scanner not responding” message is displayed, click Yes. 

• If the monitor displays the “Connection Failed” message, make sure 
that the network cable is connected properly, and that the SCANNING 
light is off. Then double click the Ettan DIGE icon on the desktop.

5 When the workstation connects to the scanner, the Ettan DIGE Window 
opens.
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3.2 Prepare the Cassette for a scan
Before scanning a sample, you must insert it in a cassette. Cassettes are 
designed to hold and store gels or membranes during scanning. They are 
chemically resistant and can withstand common gel buffers and fixatives such 
as acetic acid, ethanol, and PBS. 

3.2.1 Types of Cassettes
Gels must be scanned in a cassette. Different types of cassettes are available 
for different purposes. The Ettan DIGE Imager can be used with the following 
cassettes: 

• Ettan DALT Cassette (Ettan DIGE Imager 276x212 art no 11002704)

• SE600 Cassette (Ettan DIGE Imager 180x160 art no 11002732)

• Mounted Glass Cassette (Ettan DIGE Imager LF glass art no 11002733)

Fig 3-2. Types of Cassettes.

Ettan DALT Cassette

Mounted Glass Cassette

SE600 Cassette

DIGE_imager_11003659AC.book  Page 32  Tuesday, January 8, 2008  11:44 AM



Ettan DIGE Imager User Manual 11-0036-59 Edition AC 33

Getting Started 3

3.2.2 Loading a cassette

Assembled Ettan DALT or SE600 gels
For Ettan DIGE Imager applications the recommended glass plates have low 
fluorescence characteristics. This allows the gels to be scanned while still 
assembled within the plates. There are a number of advantages:

• Manipulation is easier and there is less risk of damaging the gel.

• Scans may be performed prior to running the bromophenol blue dye front 
off the gel so images of low molecular weight proteins, that may otherwise 
be lost, can be obtained. Gels may then be replaced in the electrophoresis 
unit to complete the run. Similarly runs can be extended and multiple 
images captured to obtain greater separation of higher molecular weight 
proteins.

Note: Wear powder free gloves. The powder used in laboratory gloves can 
fluoresce and may also scatter light affecting image quality.

• Use the Ettan DALT Cassette for an assembled Ettan DALT gel.

• Use the SE600 Cassette for an assembled SE600 gel.

To load a cassette
1 Clean the gel glass plates with distilled water using a lint free cloth. It is 

important that the glass plates are clean, dry and free from lint. If 
necessary, clean the inside lid cover of the cassette with distilled water.

2 Insert the dried glass plates into the cassette with the shorter plate facing 
down. See figure 3-3 Inserting plates in a DALT Cassette.

The shorter plate should rest in the seal at the bottom of the cassette. The large 
plate should hang over the area at the rear of the cassette.

Note: The positioning of the strip on the gel is of importance in order to achieve 
the correct orientation of your image. After inserting the gel into the 
cassette and looking from above, if the acidic side of the strip is pointing 
to the right, the image needs to be flipped to achieve the correct 
orientation. This can easily be done using the Report viewer (see 5.5 
Rotate or Crop the Image).

Note: For experimental guidelines refer to the Ettan DIGE System User Manual, 
18-1173-17.
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Fig 3-3. Inserting plates in a DALT Cassette.

3 Put the lid on the cassette and close the cassette by turning the locking 
cams up, as illustrated in Fig 3-4.

Fig 3-4. Closing the cassette locking cams.

Bound gels
Gels that are cast on Bind-Silane treated glass plates remain attached to the 
treated plate when the top plate is removed. 

Note: Make sure that the smaller glass plate of the Ettan DALT is the one treated 
with Bind-Silane.
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Gel fixing and staining is performed on the bound gel (e.g. using Deep Purple 
stain). Once the staining procedure has been completed the gel can be placed 
in the cleaned Ettan DALT/SE600 Cassette in two ways:

1 Gel side up - place in the cassette with the gel side up, in the same manner 
as described for assembled gels. Ensure that the glass plate is cleaned and 
dried before inserting it into the cassette. 

Note: To achieve the correct orientation of your image, it is assumed that 
you have bind silane treated the shorter plate and that the strip was 
placed with the acidic side to the right (having the shorter plate 
towards you when putting on the strip). However, the image can 
easily be flipped using the Report Viewer (see 5.5 Rotate or Crop the 
Image).

2 Re-assembled - the untreated plate (which was previously removed), can 
be replaced to reform the glass-gel-glass sandwich. To do this a small 
quantity of the gel storage buffer / fix solution needs to be applied to the 
bound gel and the upper plate carefully lowered onto the gel taking care to 
exclude air bubbles. Alternatively, the bound gel can be kept submerged in 
the gel storage solution and the upper plate applied. In either case the outer 
plates need rinsing with de-ionized water and then wiping dry with lint free 
tissues before being placed in the cassette. Follow the instructions for 
assembled gels.

Naked gels or gels other than Ettan DALT and SE600
For naked gels and gels other than Ettan DALT or SE 600, the cassette with the 
permanently mounted glass plate - Mounted Glass Cassette - should be used. 

1 Clean the glass plate with distilled water and dry it using a lint free cloth. 
Since fluorescent material has come into direct contact with the glass plate 
we recommend using a lint free tissue moistened with 10% hydrogen 
peroxide to remove this material, followed by cleaning with distilled water.   

2 Place the gel(s) directly on the plate. First squirt a small amount of distilled 
water onto the plate, taking care to exclude air bubbles as the gel is 
positioned. 

Note: Up to six small gels can be placed on the gel plate.

3 Note the positions of the gel boundaries on the plate, See Fig 3-5. You will 
use this information to determine the area(s) to be scanned, see 3.3 Set Up 
a scan.
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Fig 3-5. Marking gel position on a standard cassette.

4 Put the lid on the cassette, see Fig 3-4, and close the cassette by turning the 
locking cams up. 

Membranes
When scanning membranes the cassette with permanently mounted glass 
plate - Mounted Glass Cassette - should be used. In order to achieve optimal 
calibration when scanning, the black plastic hold down plate should be placed 
on top of the membranes.

Note: Wear powder free gloves when handling the cassette and membranes. 
The powder used in laboratory gloves can fluoresce and may also scatter 
light affecting image quality.

To load a cassette
1 Clean the glass plate with distilled water and dry it using a lint free cloth. 

Since fluorescent material has come into direct contact with the glass plate 
we recommend using a lint free tissue moistened with 10% hydrogen 
peroxide to remove this material, followed by cleaning with distilled water. 

2 Place the membrane(s) directly on the plate with the protein side facing 
down. If the membrane(s) is wet make sure to exclude air bubbles when 
positioning it. 

3 Note the positions of the membrane boundaries on the plate. You will use 
this information to determine the area(s) to be scanned, see Set Up a scan.

4 Place the hold down plate in the cassette on top of the membranes.

V, 10

J, 24

DIGE_imager_11003659AC.book  Page 36  Tuesday, January 8, 2008  11:44 AM



Ettan DIGE Imager User Manual 11-0036-59 Edition AC 37

Getting Started 3

5 Put the lid on the cassette (see Fig 3-4), and close the cassette by turning 
the locking cams up.

3.2.3 Inserting a cassette

To insert the cassette
1 Slide the Scanner door (at the top of the scanner) until it is fully open.

Fig 3-6. The Scanner door

2 Insert the cassette into the scanner as follows: 

Insert the cassette with the cams towards you and tilted up so that the 
cassette fits under the beveled edge on the carrier.
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Fig 3-7. Inserting the cassette

Push down and in on the front of the cassette to lock it in place.

Fig 3-8. Locking the cassette

3 Close the scanner door.
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3.3 Set Up a scan
Start the Scanner Software by double clicking the Ettan DIGE Imager icon 

on the workstation desktop or by using the start menu: Start:Programs/
GE Healthcare/Ettan DIGE Imager. The scanner software Ettan DIGE Imager 
window opens in Setup View.

Fig 3-9. The Ettan DIGE Imager Setup View

1 The Tool Bar is used to manage scan templates and to turn on the scanner 
light

2 The Navigation Bar shows the status of the scan workflow.

2. The Navigation
Bar

3. The Information
Area

4. The Setup Area 

5. The Grid Area 

1. The Tool 
Bar 

Choose matrix type here
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3 The Information Area shows the instrument status, displays information 
about the scan, and includes the SCAN button that is used to start a scan.

4 The Setup Area contains the parameters and settings for the scan.

5 The Grid Area defines the area or areas to scan. The grid coordinates are 
aligned with those on the cassette. 

3.3.1 Scanning gels

Set up a gel scan
In the Setup Area of the setup view, the parameters and settings for the scan are 
set. 

Fig 3-10. Parameters and settings in the Setup Area

The steps below do not have to be performed in a strict order.

1 Matrix type 
Choose Gel in the Matrix type drop down list.

2 Gel format
The Gel format list is used to set the scan area. There are three options for 
setting the scan area:

Option 1 - Predefined Gel Formats
For Ettan DALT, SE600 gel and for one to six naked miniVE gels there are 
predefined gel formats (see section 4.2 Standard and Custom Gel Formats)

Option 2 - User Select
In this mode, you can manually set the area to be scanned (e.g. can be used 
when scanning two naked minVE gels). In the Gel Format list in the Setup 
Area, choose User Select . Then use the mouse and drag a box. 

Option 3 - User defined gel format /custom gel format
You can use a predefined (custom created) gel format from the Gel Format 
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list in the Setup Area. See section 4.2.2 Create Custom Gel Formats for 
information about how to create custom gel formats.
Select the appropriate gel format for your sample.
The scan area is shown as a blue box in the Grid Area

Fig 3-11. Grid Area. 

3 Chemistry
Specify the type of chemistry used for your sample by selecting an item in 
the Chemistry list.

4 Pixel Size
Select the pixel size, i.e. resolution to use, in the Pixel size list. 100 μm should 
be used if images are to be analyzed by DeCyder.

5 Channels and dyes
Select the number of channels to be scanned by clicking the Channel check 
box. Between one and four channels can be programmed. Selection of the 
Channel check boxes must be performed in sequential numerical order.
For each selected channel, select a dye to be scanned in that channel. 
When selecting a dye, the excitation and emission filters that are used with 
that dye are automatically displayed by the software. The excitation and 
emission filter combinations have been selected to deliver optimum results 
with a minimum of crosstalk. 

Fig 3-12. Filter settings
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Note: There are two filter combinations for Deep Purple and Sypro Ruby, 
available as Deep Purple/Sypro Ruby 1 and Deep Purple/Sypro Ruby 2. 
Deep Purple 1 and Sypro Ruby 1 should be used for optimum results 
whereas Deep Purple 2 and Sypro Ruby 2 are optional filters to be used 
in order to minimize crosstalk, i.e. when Cy dyes are present in the gel.

If you have selected DIGE file naming format, and have a standard defined 
in your experiment, specify which dye represents the standard under 
Standard.

6 Exposure
Select the exposure to be used for each channel in the Exposure list. A quick 
test scan on a small area should be performed initially to identify a suitable 
exposure. See section  3.4.1 Finding the optimal settings.

7 Comments
You can optionally add comments to your data. To add comments to the 
data:

1. At the bottom of the Setup Area, click Experiment Comments to open the 
Experiment Comments dialog box.

2. Enter the Gel ID, the Individual Source, and the Sample ID. 

3. Enter Comments for the scan. To use the same comments for all the gels 
in this scan, select Use this Comment for all Gels. (This option only applies 
to the Comments field. All other fields are always specific to each gel area.)

4. Click Close.
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3.3.2 Scanning membranes

Set up a membrane scan
In the Setup Area of the setup view, the parameters and settings for the scan are 
set.

Fig 3-13. Parameters and settings in the Setup Area.

1 Matrix type: 
Choose Membrane from the Matrix Type list.

Note: When scanning membranes the black plastic hold down plate should be 
used. See page 36.

The following steps do not have to be performed in a strict order.

2 Gel format
The Gel format list is used to set the scan area. In the Gel Format list in the Setup 
Area choose User Select. In this mode, you can manually set the area to be 
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scanned. Then use the mouse and drag a box from the positions of the 
membrane boundaries. The scan area is shown as a blue box in the Grid Area.

Fig 3-14. Grid Area.

3 Chemistry
When scanning membranes the Chemistry should be Unassigned.

4 Pixel Size
Select the pixels size, i.e. resolution to use, in the Pixel size list. 100 μm should be 
used.

5 Channels and dyes
Select the number of channels to be scanned by clicking the Channel check box. 
Between one and four channels can be programmed. Selection of the Channel 
check boxes must be performed in sequential numerical order. For each 
selected channel, select a dye to be scanned in that channel. When selecting a 
dye, the excitation and emission filter to be used for that dye are presented 
automatically by the software. The excitation and emission filter combinations 
have been selected to deliver optimum results with a minimum of crosstalk.

Fig 3-15. Filter settings.
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6 Exposure
Select the exposure to be used for each channel in the Exposure list. Generally 
low exposures are used for membranes. However, a quick test scan on a small 
area should be performed to identify an optimal exposure. See Finding the 
optimal settings in section 3.4.1.

7 Comments
You can optionally add comments to your data. To add comments to the data:

1 1 At the bottom of the Setup Area, click Experiment Comments to open the 
Experiment Comments dialog box.

2 2 Enter the Membrane ID, the Individual Source, and the Sample ID.

3 3 Enter Comments for the scan. To use the same comments for all the gels 
in this scan, select Use this Comment for all Gels. (This option only applies 
to the Comments field. All other fields are always specific to each gel area.)

4 4 Click Close.

To start the scan and for more information see Start a scan and following 
chapters.

3.4 Scan a sample 

3.4.1 Finding the optimal settings
The exposure can be set from 0.02 to 4. The exposure chosen depends on the 
type and quantity of fluorophore present. A test-scan, scanning only a small 
area, should be performed to identify a suitable exposure. This allows a rapid 
scan that will help finding the optimal settings. The area should be placed 
somewhere on the gel were the most intense spots are supposed to be.

For the E.coli model system used at GE Healthcare (50 μg protein labeled with 
400 pmol dye, run on 24 cm pH4-7 NL Immobiline DryStrips strips that are then 
used with the second dimension run on Ettan DALT gels) the following exposure 
levels can be used as guidelines:

CAUTION: The maximum pixel value should not exceed 65 000 counts. If some 
of the pixel values are equal to or greater than 65 000 counts, part of your 
image is at or near saturation. This will prevent correct quantitative analysis. 
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Fig 3-16. Choosing a small test scan area

Fig 3-17. Scan finished.

Fluorophore  Exposure levels

Cy2 0.8

Cy3 0.3

Cy5 0,5
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A target signal of 30 000 to 55 000 is usually suitable. Similarly if only one or two 
spots show saturation then only minor downward adjustments to the exposure 
setting are normally required. It is not necessary to optimize scan settings for 
every gel. To avoid problems with saturated images it is recommended that 
users confirm that suitable image signals have been obtained before discarding 
gels. Once the exposure has been selected for one gel in an experiment all 
similar gels within the same experiment should be scanned using the same 
exposure. 

After you have entered the settings for the scan, use the following instructions 
to scan the sample.

3.4.2 Start a scan
1 Make sure that the Instrument status in the Information area displays 

“Ready” and that the READY light on the scanner is on.

2 If the Instrument status is “Lamp Off”, click  on the toolbar or go to the 
menu under Instrument/Toggle Lamp and wait until the lamp warms up. 
The Scanner Lamp Warming Up Message box displays an estimated time 
of “when the scanner will be ready” and closes when the lamp is warmed 
up, this takes approximately 5 minutes. When the Scanner Lamp is warm 
the READY light is on.

3 Click the SCAN button to start the scan.

4 In the File Name Dataset dialog box, browse to a directory and enter a 
name for the dataset, or choose New folder to create a new folder.

DIGE_imager_11003659AC.book  Page 47  Tuesday, January 8, 2008  11:44 AM



3 Getting Started
3.4 Scan a sample

48 Ettan DIGE Imager User Manual 11-0036-59 Edition AC

Fig 3-18. File Name Dataset dialog box 

Note: Depending on whether the DIGE File Naming Format check box has been 
selected or not the scanned files will end up with different filenames and 
folder structure, see 6 File formats for more information on DIGE File 
Naming Format.

Note: Dataset names must be unique. If you enter the name of an existing 
dataset, you will be prompted to overwrite it .

5 Click Proceed to start the scan.

After you press the SCAN button, the view changes to Scan and the bottom label 
changes to STOP. 
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Fig 3-19. The Scan View

1 The Navigation Bar indicates Scan View.

2 The STOP button interrupts a scan. 

3 The Information Area displays the estimated scan time and the progress 
of the scan.

4 The Status Bar displays the channel intensity ranges and saturation values 
for each panel after it is scanned.

5 The View Area displays scan data for each channel as it is scanned.

3. The Information 
Area

5. The View Area

6. The Scan Summary Area4. The Status Bar

1. The Navigation 
Bar

2. The STOP button
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6 The Scan Summary Area at the bottom right corner shows the scan 
settings. 

While the samples are being scanned, monitor the data quality of each channel 
in the View Area and Status bar. 

The data is scanned in horizontal panels (strips) across the scanned area. The 
data for all of the channels in a panel is scanned before moving to the next 
panel.

1 The Status bar displays the channel intensity ranges and saturation values 
for each panel after it is scanned. Saturated areas of the displayed channel 
are shown in red. 

2 If the data for any of the channels are saturated or underexposed, you can 
stop the scan and change the scan settings as follows:

a) On the left side of the Scan window, click the STOP button.

Note: When you click the STOP button all scanned data is deleted. 

b) When prompted, click OK to cancel the scan.

c) On the Navigation Bar, click Setup.

d) In the Exposure field, change the exposure. (If the scan data is too faint, 
enter a larger exposure. If it is overexposed, enter a smaller exposure.)

e) Click the SCAN button to restart the scan.

3 Monitor the scan and adjust exposure values, as shown in Steps 2c and 2d 
above, until you are satisfied with the quality of the data and let the scan 
finish. Please see 3.4.1 Finding the optimal settings for a quick way of finding 
the right settings.

4 As the scan is completed, a message indicates that the scanner is creating 
gel files.

Note: When scanning more than one channel, scan data files (in a .gel format) 
are created in the dataset directory. Two identical index files (in a .ds 
format) are also created. One index file resides in the dataset directory. 
The other index file resides at the same level as the dataset directory. 
When scanning one channel only scan data files in a .gel format are 
created.

When the scan is complete, the Scan Finished dialog box appears.
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Fig 3-20. Scan finished dialog box

5 To close the Scan Finished dialog box and return to the Setup View, click 
Return to Setup.

6 To view a report, choose a scan area in the Select Scan Area list and click 
View Report .
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3.5 The Report view

Fig 3-21. The Report Viewer

The Report Viewer summarizes the View area and the Information Summary 
area of the Scan View. 

Use the Report Viewer to view an image of each channel, along with the scan 
settings and comments associated with the scan data. 

You can use the Report Viewer to reorient or crop the scan data. You can also 
use it to adjust brightness and contrast of the display, measure features, and 
add a scale bar. See 5 Using the Report Viewer.

To print reports

• To print Scan reports for all of the dyes, choose File:Print All in the Report 
Viewer menu. 
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• To print a scan report for a specific dye, select the Dye tab 
 in the Report viewer. Then choose File:Print Current 

in the Report Viewer menu. 

3.6  To turn off the system
1 Save all data files.

2 In the Ettan DIGE window, choose File:Exit to close the scanner software.

3 Shut down the workstation.

4 Turn the Power switch off to shut down the scanner.
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4 Customizing Templates and Gel Formats

This chapter shows how to create and modify a template and how to set up a 
custom format to scan gels. 

4.1 Templates
You can create templates that save the gel formats and scanner parameters for 
a scan. When you load a similar type of sample in the cassette, you can open 
the template that loads these scan settings. This is useful when you are 
scanning a number of samples that have similar attributes. 

4.1.1 Create a New Template
You can create a new template after you set up a scan. If you have already 
created a template that is similar to what you need, you can load it , modify it , 
and save it with a different name using Save as.

To create a template from a scan
1 Set up a scan as shown in 3.3 Set Up a scan. 

2 In the File menu, choose Save Template As. Then enter the name for the 
new template in the Scan Template Name field and click OK.

The new template is saved in your user preferences. When you are logged on to 
your account, it appears in the Open Scan template dialog box. (The template is 
not available to other users.)

To create a template from an existing template
1 In the Ettan DIGE Imager window, choose File:Open Template and select a 

template in the Open scan template dialog box.
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2 In the Setup area, modify the settings for the Gel Format, Chemistry, and 
other parameters and select the dyes for the new template.

3 In the File menu, choose Save Template As. Then enter the name for the 
new template in the Scan Template Name field and click OK. 

4.2 Standard and Custom Gel Formats
The gel format controls the shape of the scan area. If you are using a DALT gel, 
you can use the standard DALT gel format (Ettan DALT). You can also use 
standard formats for any other gels, provided that these formats scan all of the 
areas covered by the gels.

4.2.1 Standard Gel Formats
The Gel Format list includes the following standard Gel formats. These formats 
are read only and cannot be modified. 

CAUTION! When setting up a gel format, make sure that the scan area 
includes all of the area covered by the gel. (Because the gels have irregular 
shapes, some areas outside of the gel perimeter should be scanned.)
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Fig 4-1. Standard Gel Formats

4.2.2 Create Custom Gel Formats
You can create custom gel formats to scan irregular areas. This is especially 
useful when you are scanning “naked” gels.

To create a custom gel format
1 Open the cassette and note the position of the gel areas, based on the 

numbers and letters on the side of the cassette. Make sure that the 
rectangles formed by the coordinates cover the entire sample. Then load 
the cassette into the scanner.

Ettan DALT

Hoefer SE600

Hoefer miniVE
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Fig 4-2. The gel area

2 In the Gel Format list on the Ettan DIGE Imager window Setup area, choose 
User Select.

3 Click and drag the mouse across the grid area to create new scan areas 
that match the areas on the cassette.

G, 2

T, 31

G, 17

U 16
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Fig 4-3. Creating a custom scan area

4 From the Gel Format menu, choose Save to save the changes to the new 
format.

5 In the Save Gel Format dialog box, enter a new format name, and click OK 
to save the new format.

The new Gel format is added to the Gel Format list.

Tips for modifying scan areas
To move the scan area, hold down 
the left mouse button on the area 
and drag the mouse.

To change the size of the scan area, 
use the mouse to drag an edge or 
corner of the scan area.

To delete a scan area, select it and 
press the Delete key. 

To specify not to scan an area, 
double click on the area. (The area is 
grayed out.)

1 2
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5 Using the Report Viewer

This chapter shows how to use the Report Viewer to document scan data. 

5.1 About the Report Viewer
You can use the Report Viewer to perform quality control checks, crop images 
and to print scanned images. This tool allows you to examine the scanned 
images and to rotate and flip them, if needed, to get the orientation used in 
DeCyder. You can choose to open the Report when a scan is complete or you 
can open it by clicking Report in the navigation bar.

Fig 5-1. The Report Viewer window has four main areas.

1 The Tool Bar across the top of the window is used to open, save, or print 
images. 

1. Tool
Bar

2. Image
Controls

3. Image Area

4. Report Area
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2 The Image Controls on the left side of the window allow you to control the 
display of the image.

3 The Image Area displays one channel of the scanned image. Use the tabs 
at the bottom of the window to view different channels. 

4 The Report Area at the bottom of the window displays the data for the 
scan, including the user, date, channel descriptions, scan parameters, and 
comments.

5.2 Set the Image Contrast
You can improve the contrast of selected data in a channel by changing the 
channel's intensity scale. 

The Report Viewer uses grayscale values to display an intensity scale. The 
lightest grayscale value is mapped to the lowest (dimmest) intensity value in the 
wavelength and the darkest grayscale value is mapped to the highest 
(brightest) intensity value. The remaining grayscale values are mapped to 
values between the lowest and highest values. 

Grayscale values can be mapped to create linear or nonlinear intensity scales. 
In linear scales, the grayscale values are mapped to intensity values that are 
distributed evenly from the minimum to the maximum values. In nonlinear 

Use  To
Zoom in on a specific area. After you select this tool, drag the 
mouse across an area to select it .

Zoom in on the entire image.

Zoom out on the entire image.

Return the image to its original center and reset the zoom to the 
default level (1:1).

Reset the center of the image to a particular point of interest.

Open the Image Scaling tool to adjust the brightness and contrast 
of each channel.

Select an ROI for cropping the image.

“Quick Compare” a channel with the standard channel. This quick 
comparison is useful for quality checks. 

Show saturated areas in red.

QC
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scales, the grayscale values are mapped to intensity values that are distributed 
unevenly throughout the range.

To change the intensity scale
1 In the Report Viewer window, click  to open the Image Contrast 

window. This window shows the image intensity scale. The histogram is a 
frequency plot that shows the distribution of pixel intensities in the image 
file. The Y-axis shows the number of pixels for a given intensity.

Fig 5-2. The Image Contrast window

2 Select a Channel option to specify which channel to scale (in our example, 
we selected Cy3).

3 To change the minimum or maximum scale value, click and drag on the left 
or right white control point. 
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Fig 5-3. Image Contrast: left and right control points

As you move the control points, the displayed image changes interactively. 
Data values higher than the maximum value are assigned the lightest shade. 
Values lower than the minimum value are assigned the darkest shade.

4 To slide the range to the left or right, click and drag on the center control 
point.

Fig 5-4. Image Contrast: center control point

5 To change the intensity scale distribution, click anywhere in the histogram 
(except on the control points) and drag the mouse up or down.

Control 
Points

Center Control
Point
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Fig 5-5. Image Contrast: scale distribution

6 To undo all of the contrast changes, click Cancel.

7 To save the contrast settings, click OK. 

5.3 Display the Image Scale Bar
You can display or hide a scale bar to show the scale of the image. You can also 
set options to move the scale bar (to show the scale of a point of interest in the 
image) or to control how the scale bar is displayed. The scale bar is not 
displayed by default.

To change the image scale bar
1 Choose View:Scale Bar from the menu to open the Scale Bar dialog.

Fig 5-6. The Scale Bar dialog box

2 Select Displayed to show the Scale Bar.
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3 To display the scale as a vertical bar, select Vertical (the default is 
horizontal).

4 Adjust the Position, Length, Thickness, and Color of the scale bar. The 
scale bar changes interactively as you set these properties.

Note: To specify length, you can enter a value (in mm) in the Length field or use 
the slider. 

5 To hide the scale bar, un-select the Displayed option.

5.4 Measure Distances
Use the Measure Distance tool to measure the distance between two points, the 
distance from a single reference point to a series of points, or the distance 
between a series of points. After you complete your measurements, you can 
export them as a comma delimited list to a file that can be opened in a 
spreadsheet.

To measure distance
1 In the Report Viewer window, choose Tools:Measure Distance to open the 

Measure Distances dialog box.

Fig 5-7. The Measure Distance tool 

2 Select the Standard Two Point method in the Measurement Method list. 
The Measurement Method list has the following options: 

Standard Two Point measures the distance between two points. 
Measurement starts over after the second point.

Single Reference measures distances from a single reference point. The 
first point serves as the reference point. The distance is measured between 
this reference point and subsequent points.
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Leap Frog measures the distance between two points. The end point of 
each measurement serves as the start point of the subsequent 
measurement.

Multiple Segment measures the distance between a series of points.

3 Select which unit to use for measurement in the Distance Units list.

4 To display lines between points, select Draw Lines. 

5 To display point labels on the image, select Label Points.

6 Use the mouse to select two points in the Image window. 

Fig 5-8. Selecting points to measure

7 In the following example, Line 1 consists of Point 1 and 2 and is 362.365 
millimeters long.

Selected Points
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8 When you are finished, click Export Data to save the list as a .csv file. (This 
format can be opened in a spreadsheet.)

9 View the results of measurements in the Point List table.

5.5 Rotate or Crop the Image
You can rotate or crop the image in the Report Viewer. This can be useful for 
interpreting or presenting the data.    

5.5.1 Rotate the Image
You can use several methods to reorient the image.

To Reorient the Gel Image 

• In the Edit menu, choose one of the following items:
Flip X flips the image horizontally.

Flip Y flips the image vertically.

Rotate 90 rotates the image 90° clockwise.

Invert XY switches the X and Y axis and reverses the orientation of the axes.

5.5.2 Crop the Image
Crop the image to include only the areas that include data.

To Crop the Image 
1 On the Report Viewer tool window, select the ROI  (Region of Interest) 

tool.

2 Drag the mouse across the area of interest to define the ROI.
The ROI is displayed as a square 
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Fig 5-9. Region of Interest (ROI)

3 In the Edit menu, choose Crop.
The image is cropped to include only the data that is within the ROI.

5.5.3 Restore the Image
You can restore the image to its original state.

To restore the Image 

• In the Edit menu, choose Restore.
The image is restored to its original position and size.

5.5.4 Save the Modified Data
You can save the modified data to a new data set.
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To save the data 
1 On the File menu, choose Save As to save the dataset

Fig 5-10. File Name Dataset dialog box

2 In the File Name Dataset dialog box, browse to the directory in which to 
save the dataset. Then enter the Dataset Name and click Save.

5.5.5 Improve Report Viewer performance
You can improve the performance of Report Viewer tools by allocating a second 
memory buffer in the Preferences dialog box.

To improve performance of Report Viewer tools
1 From the Ettan DIGE Imager window Edit menu, choose Preferences.

2 On the Preferences Dialog box, select Allocate second buffer for quick 
rotate.
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6 File formats

6.1 DIGE File Naming Format
Using the DIGE File Naming Format option results in all files having user defined 
(and ideally unique) filenames. All scan images from a given experiment can be 
saved into a single user defined directory. This method of file naming and 
directory selection results in structures that can be directly used by DeCyder 
image analysis software.

If a single scan setting has been chosen, e.g. for a Deep Purple stained gel, then 
the resulting output on scan completion will be a filename.gel file in the selected 
directory. If two or more scan parameter settings were chosen, e.g. for a Cy2/
Cy3/ Cy5 gel, then the resulting output on scan completion will be a filename.ds 
file in the selected directory and a new directory called filename.dir. In this new 
directory will be a filename.ds file and filename suffix.gel files, were the suffix 
can be Cy2, Cy3 or Cy5 and the channel that is selected as standard will also 
have STANDARD as suffix, e.g. Scan1 STANDARD Cy2.gel. The filename.ds file 
allows the scanned images to be overlaid in ImageQuant whilst the filename 
suffix.gel files are the individual scan channel outputs and can be viewed as 
separate files.

6.2 Standard File Naming Format
The DIGE File Naming Format check box is left unselected in this mode. If a single 
scan setting has been chosen, e.g. for a Deep Purple stained gel, then the 
resulting output on scan completion will be a filename.gel file in the selected 
directory. If two or more scan parameter settings were chosen, e.g. for a Cy2/
Cy3/Cy5 gel, then the resulting output on scan completion will be a filename.ds 
file in the selected directory and a new directory called filename. In this new 
directory will be a filename.ds file and files called UNSEP1.gel, UNSEP2.gel and 
UNSEP3.gel. The filename.ds file allows the scanned images to be overlaid in 
ImageQuant whilst the UNSEPn.gel files are the individual scan channel outputs 
and can be viewed as separate files. 

6.3 Gel file format
The images generated by the Ettan DIGE Imager are saved as tiff files. However, 
in order to get more information (e.g. instrument settings and comments) saved 
with the image, .gel files are automatically created. 
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7 Maintaining the System

This chapter describes procedures required to keep the system hardware in 
optimum operating condition.

7.1 Electrostatic Discharge (ESD)
There is a risk of damaging electronic components with electrostatic discharge 
when you are performing the maintenance tasks described in this chapter. The 
following guidelines will help you avoid electrostatic discharge.

Electrostatic discharge is the release of static electricity from one place to 
another. Static charges are easily generated and can be stored on people and 
various materials, including plain plastics. People often carry charges of 1000 to 
5000 V but do not feel the sensation of a discharge under 3000 V. Plastics can 
hold charges of several hundred to 25,000 V. A few hundred volts can damage 
most semiconductor devices in a fraction of a microsecond.

7.2 Clean the System
Wipe the surfaces of the scanner as needed with a lint-free cloth slightly 
moistened with water or 10% ethanol in water. 

7.3 Replace the Protective Window
The Protective Window is a sealed glass window that protects the optics from 
spills and exposure to cleaning fluids. It fits over the camera lens. If the window 
is scratched or damaged in any other way, order a new window and use the 
following instructions to replace it . 

CAUTION! When you turn off the scanner, keep the power cord plugged in so 
that the system is electrically grounded. The system contains microelectronic 
devices that can be damaged by electrostatic discharge.
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Fig 7-1. The Protective Window

To replace the Protective Window
1 Turn off the scanner.

2 If a cassette is on the stage, remove it . 

3 Slide the stage to the right to expose the Protective window. 

4 Remove the two screws that hold the window to the stage platform.

5 Insert a screwdriver under the indented slot and lift the edge of the window 
up to remove it .
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6 Place the new window on the o-ring in the window holder.

7 Tighten the two screws that hold the window in place until they are snug.

8 Turn on the scanner. (The stage homes itself to its original position.) 

7.4 Replace the Lamp Assembly
The lamp assembly provides light to the optical system. The assembly consists 
of a metal-halide bulb and lamp housing.

After 1000 hours of use, the bulb in the lamp assembly can no longer supply the 
intensity and spectral range of light required by the scanner's optics. 

In order to ensure that the bulb is properly aligned in the optical system, replace 
the entire assembly as a unit.
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7.4.1 Safety
There are three risks associated with handling the lamp assembly: exposure to 
heat, exposure to ultraviolet light, and exposure to mercury vapor. Oil from 
fingerprints on the bulb can heat up and cause the bulb to explode when it is 
turned on, releasing dangerous vapor.

Observe the following safety precautions when handling the bulb assembly:

• Do not open the lamp access door while the lamp is turned on.

• Wait for the lamp assembly to cool before handling the assembly.

• Do not touch the bulb. Use lens tissue or a lint-free cloth to handle the bulb. 
Clean fingerprints from the bulb using an organic solvent such as ethanol 
and a lint-free cloth.

Note: The rear panel is equipped with a safety interlock. If you open the rear 
panel while the lamp is turned on, the safety interlock turns off the lamp.

7.4.2 Overall steps for replacing the lamp assembly
A: Turn off the scanner and allow the lamp assembly to cool.

B: Replace the assembly.

C: Reset the bulb age counter in the scanner software.

D: Perform a flat-field calibration.

To change a lamp assembly
1 Turn off the scanner as follows:

• Make sure that there is not a cassette in the scanner.

• Turn off the scanner.

• If you just turned off the lamp, wait fifteen minutes for it to cool.

WARNING! Under certain conditions, the bulb can explode. If this 
occurs, the fumes can be toxic. Evacuate the room immediately 
and remain out of the room for at least 30 minutes.

WARNING! The lamp assembly can get extremely hot. Make sure 
that the lamp is turned off and has cooled for at least fifteen 
minutes before replacing the lamp assembly.
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2 Replace the lamp assembly:

• Remove the rear panel of the scanner by loosening the two screws at 
the bottom of the panel.

Fig 7-2. Removing the rear panel screws

• Gently pull up on the panel as you open it and remove the door.

Fig 7-3. Removing the rear pane

• Open the lamp Access door.
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Fig 7-4. The Lamp Access door

• Remove the two lamp assembly thumb screws at the lower left and 
upper right hand corners of the lamp base.

Fig 7-5. Lamp assembly screws and plastic knob

• Grasp the plastic knob and gently pull out the lamp assembly.

Lamp Access
Door

CAUTION! If the plate is hot, wait for it to cool before unscrewing the lamp 
assembly screws

Plastic 
Knob

Lamp As-
sembly 
Screws

DIGE_imager_11003659AC.book  Page 78  Tuesday, January 8, 2008  11:44 AM



Ettan DIGE Imager User Manual 11-0036-59 Edition AC 79

Maintaining the System 7

• Disconnect the lamp cable from the assembly and put the assembly 
aside.

Fig 7-6. Lamp Cable Connector and Assembly

• Remove the new lamp assembly from its packaging.

Note: Use only replacement bulbs supplied for this system. 

WARNING! DO NOT TOUCH THE BULB! Fingerprints on the bulb 
can cause it to overheat when it is turned on and possibly 
explode. If this occurs, evacuate the room immediately and 
remain out of the room for at least 30 minutes. Order a 
replacement bulb assembly.

Lamp Cable Connector

Lamp Assembly
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• Being careful not to touch either the front or back of the bulb, make sure 
that the clips securely attach the bulb to the plate.

• Connect the lamp cable to the new assembly. The cable connectors are 
keyed so that they only connect in the correct position.

• Install the lamp assembly. Be careful not to pinch the cables.

• Hold the lamp assembly plate flush against the scanner frame and 
finger-tighten the two lamp assembly thumb screws clockwise. 

• Close the lamp access door and install the rear panel.

3 Reset the bulb age counter as follows:

• Start the system.

• Open the Ettan DIGE Imager Scan window and choose 
Instrument:Reset Lamp Age. 

• When prompted, click OK to set the lamp age to zero.

4 Perform a flat-field calibration as follows:

• Place the special calibration paper in a cassette and then place the 
cassette in the scanner.

• From the Ettan DIGE Imager window menu, choose Instrument:Flat 
Field Calibration.

• When prompted, click OK to calibrate the scanner.

CAUTION! Do not use a screwdriver to tighten the assembly plate screws.
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8 Troubleshooting

8.1 Customer verification test target
Enclosed with the instrument is an instrument verification test target. It can be 
used to check that the instrument is working properly. Simply place the target 
on the glass plate of the sample cassette so that the numbers appear with 
normal orientation, prevent the target from moving by securing it with two 
pieces of tape and scan the whole area with 100 μm resolution. If the target is 
not completely flat, put a glass plate on top. Recommended settings are: Cy2 
channel, 0.12 exposure level.

The result should be an image similar to the one in Fig 8-1 Test result and the 
resulting image can be evaluated to check for the following issues:

Stitching accuracy: All horizontal and vertical lines should appear stepless in the 
image

Camera focus: With 100 μm resolution one line should not cover more than 2 
pixels 

Pixel size accuracy: The distance printed on the test target should match the 
distances measured with an image evaluation program.

The test target should be stored in a dark place.

Fig 8-1. Test result

Note: Other problems should be handled by GE Healthcare service personnel.
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Appendix A

A.1 Filter Details

Dye Excitation Filter Emission Filter

Cy2  480/30 nm 530/40 nm

Cy3 540/25 nm 595/25 nm

Cy5 635/30 nm 680/30 nm

Deep Purple 1 540/25 nm 595/25 nm 

Deep Purple 2     390/20 nm 595/25 nm 

SYPRO Ruby 1 480/30 nm 595/25 nm 

SYPRO Ruby 2 390/20 nm 595/25 nm 
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A.2 Spare Parts

Article Article no.

Lamp Assembly 28401403

Protective glass window 28401414
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